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I.Introduction
Ceci est un guide pas à pas pour l'observation d'exoplanètes à la fois pour le débutant et  pour
l'observateur expérimenté. Pour le premier, il est souhaitable d'avoir une expérience en ciel profond
ou d'imagerie d'étoiles variables. Pour le second pourra trouver ce guide très utile comme un rappel
sur  les  bonnes  pratiques,  et  comme  un  guide  pour  l'utilisation  d'AstroImageJ  (AIJ)  pour  le
traitement des images et la modélisation de transit d'exoplanètes. AIJ est un logiciel libre qui est un
intégré pour la calibration des images, la photométrie différentielle et la modélisation d'exoplanètes.

Ce guide vous conduira à travers toutes les phases de l'observation d'exoplanètes, à la sélection de
cibles adéquates pour modéliser les transits. Les transits d'exoplanètes connus sont utilisés pour
démontrer les techniques et les capacités d'AIJ dans la modélisation de transit exoplanétaire.

Liens pour la dernière version de ce guide et le matériel qui l'accompagne  http://astrodennis.com.

Lien  vers  la  dernière  version  d'AIJ,  son  guide  utilisateur  et  son  forum:
http://www.astro.louisville.edu/software/astroimagej/.

II. Historique
En  1995,  Pegase  b  a  été  la  première  exoplanète  détectée  autour  d'une  étoile  de  la  séquence
principale.. A ce jour, plus de 3 200 exoplanètes ont été confirmées par le satellite Kepler ou des
observations au sol.

Les astronomes amateurs ont détecté avec succès des exoplanètes depuis au moins une dizaine
d'année  et  avec  une  précision  incroyable  !  De  plus,  ils  ont  été  capables  de  faire  de  telles
observations avec le même équipement qu'ils emploient pour créer les fabuleuses images du ciel
profond ou les courbes de lumières d'étoiles variables.

De nombreux exemples existent d'astronomes amateurs qui fournissent des données importantes
dans la recherche d'exoplanètes. En 2004, une équipe d'astronomes amateurs et professionnels ont
collaboré au projet XO, qui a débouché sur la découverte de plusieurs exoplanètes. Le programme
KELT (Kilodegree Extremely Little Telescope) utilise un réseau mondial d'astronomes amateurs et
de collèges, avec des astronomes professionnels, pour conduire le suivi d'observations d'exoplanètes
candidates en transit devant des étoiles brillantes.

Un réseau d'amateurs est actuellement en train d'appuyer la surveillance par Hubble de quelques 15
exoplanètes,  par observations dans le visible,  Hubble observant dans le proche infra-rouge. Ces
observations d'astronomes amateurs aident à affiner les éphémérides d'exoplanètes confirmées. Le
simple  fait  que  des  astronomes  amateurs  peuvent  modéliser  avec  précision  des  transists
d'exoplanètes  confirmées,  veut  dire  qu'il  leur  est  possible  théoriquement  d'en  découvrir  !  Par
exemple, en détectant des variations pendant la durée du transit (TTV transit time variation) d'un
exoplanète confirmée, ils pourront détecter l'existence d'une autre exoplanète orbitant autour de
l'étoile hôte.

La formalisation de bonnes pratique pour la détection d'exoplanètes par les astronomes amateurs a
commencé en 2007 avec la publication de Bruce Gary "Observation d'exoplanètes pour amateurs".
Au  même  moment  Gary  commença  l'archivage  d'observations  d'exoplanètes  d'autres  amateurs.
Cette archive, l'Archive d'Exoplanètes Amateurs (AXA), a été ensuite transférée vers le projet ETD
(Exoplanet Transit Database), une archive en ligne sponsorisée par la société astronomique tchèque
(http://var2.astro.cz/ETD/contribution.php).

http://www.astro.louisville.edu/software/astroimagej/
http://astrodennis.com/


III. Observation des exoplanètes
Le concept de base de l'observation d'exoplanètes implique une série d'images du champ entourant
l'étoile hôte, avant, pendant et après le transit prévu de cette planète.

Les  transits  durent  typiquement  de  2  à  4  heures.  Cependant  il  est  souhaitable  que  la  session
d'imagerie commence 1 heure avant et finisse 1 heure après le transit. Donc la session peut durer de
4 à 6 heures.

Une technique appelée photométrie différentielle est utilisée pour déterminer les changement de
brillance, de flux lumineux, de l'étoile hôte qui est susceptible d'indiquer qu'on est en présence d'un
transit planétaire. Cette  technique compare les différences relatives entre l'étoile hôte et une ou
plusieurs  étoiles de comparaison (en assumant que ce ne sont pas étoiles variables) pendant la
session  d'imagerie.  Puisque  les  différences  de  brillance  de  l'étoile  hôte  et  des  étoiles  de
comparaisons (comps) sont également influencées par des facteurs communs (passage de nuages,
lumière  lunaire,  pollution  lumineuse,…),  un  changement  dans  ces  différences  serait  alors  une
mesure d'un transit planétaire. 

Afin de déterminer ces différences de brillance entre l'étoile hôte et les comps, l'utilisateur doit
d'abord définir une "ouverture" et un "anneau" placés sur l'étoile hôte et les comps (voir figure 1).
La brillance de la zone annulaire (mesure du fond du ciel) est ensuite soustraite de la brillance de la
zone d'ouverture pour obtenir la valeur correcte de la brillance de chaque étoile. En même temps,
chaque comp est comparé aux autres comps de manière à établir que l'on n'est pas en présence d'une
étoile variable.

Figure 1. Ouverture (vert) et anneau (rouge)

Les points de données qui représentent les variations relatives de brillance de l'étoile hôte sont
ensuite utilisés pour modéliser le transit exoplanétaire. Un modèle plus ajusté est alors créé à partir
de ces points. Ce modèle ajusté résulte de l'estimation de paramètres clés de l'exoplanète et de son
transit. Ces paramètres comprennent:

1. Le carré du rapport du rayon de l'exoplanète (Rp) à celui de son étoile (R*),

2. le rapport de demi grand axe orbital de l'exoplanète (a) à R*,

3. Le point central de transit Tc et la durée du transit,

4. L'inclinaison de l'orbite de l'exoplanète par rapport à la ligne de visée de l'observateur.

Aussi, en connaissant le rayon R* de l'étoile hôte, l'observateur peut réellement estimé le rayon de
l'exoplanète, aussi bien que son demi grand axe.



IV. Les bonnes pratiques
Ce qui  suit,  sont  plusieurs  bonnes  pratiques  pour  capturer  un  transit  exoplanètaire  qui  devrait
résulter dans une meilleure qualité des données collectées:

1.  Echelle de l'image (en arc-secondes par pixel): L'échelle de l'image du système, en tenant
compte  du  binning  de  la  camera  CCD,  devrait  être  tel  que  le  FWHM (Full  Widht  at  Half
Maximum) de l'étoile hôte recouvre 3 pixels ou plus. Contrairement à l'imagerie du ciel profond
où  l'imageur  est  intéressé  par  des  étoiles  ponctuelles,  l'observateur  d'exoplanètes  est  plus
intéressé par la collecte précise d'information sur le flux lumineux de l'étoile hôte et des comps.
Si à cause du système d'imagerie, il n'est pas possible d'atteindre ce but, alors il est conseillé de
défocaliser l'image de façon à ce que l'étoile couvre 3 pixels ou plus. La défocalisation accroît
aussi les chances de trouver des étoiles de comparaisons convenables.

Une fonction d'étalement ponctuelle (PSF, Point Spread Function) résultant d'une défocalisation
de 10-20 pixels est acceptable, sauf si le fond du ciel est important. Cependant on devrait porter
attention à ce que la défocalisation pourrait un recouvrement de l'étoile hôte ou de l'une des
comps.

2.  Sélection des étoiles de comparaisons: Les étoiles comps utilisées devrait être aussi proche
que possible en magnitude de l'étoile hôte. Idéalement l'ensemble des étoiles comps devrait être
un mix d'étoiles dont la brillance est 0,5-1,5 fois celle de l'étoile hôte, ce qui se traduit par une
magnitude 0,75 plus élevée à 0,44 moins élevée que l'étoile hôte. Aussi, parce que les transits
complets auront lieu à différentes altitudes, la brillance des étoiles  de différents type croîtra
(décroîtra) selon que la masse d'air (AIRMASS) croîtra/décroitra. C'est pourquoi il est préférable
de choisir  des étoiles comps d'un même type stellaire.  Toutefois,  comme AIJ est  capable de
corriger les effets de masse d'air, choisir des étoiles comps de brillance similaire à celle de l'étoile
hôte est plus important que choisir  des étoiles d'un même type stellaire.  Par dessus tout, les
étoiles comps ne devront pas inclure des étoiles variables. Une bonne source d'information à ce
sujet est AAVSO’s Variable Star Plotter utility (see https://www.aavso.org/apps/vsp/).

3.  Flat: Quelque soit la méthode utilisé pour crée les images flat (panneau électroluminescent,
crépuscule, dôme,…) le résultat devrait être un champ de lumière uniforme. C'est spécialement
vrai dans le cas d'une monture équatoriale dont le retournement au méridien peut entraîner un
déplacement de la cible sur le capteur CCD. (Note: le terme étoile cible dans ce guide veut dire
étoile hôte de l'exoplanète). La section VI fournit la marche à suivre sur comment  créer des
images flat.

4. Autoguidage: Parce qu'il presque impossible de réaliser un flat qui corrige parfaitement pixel
par pixel un système d'imagerie, il est impératif que l'observateur minimise les mouvements de
l'hôte et des comps sur le capteur CCD. Ceci est réalisé en s'assurant d'un alignement polaire
parfait et d'une erreur périodique minimale. Plus important encore, l'autoguidage est nécessaire
pour assurer le meilleur suivi possible du champ imagé pendant toute la durée de capture.

5. Utilisation de filtre: Si les résultats participent à une collaboration amateurs/professionnels, un
filtre photométrique spécifique sera très probablement requis.

https://www.aavso.org/apps/vsp/


6.  Synchronisation  temporelle: L'observateur  devrait  disposer  de  logiciel  qui  synchronise
fréquemment l'horloge de l'ordinateur avec le serveur temporelle internet de l'observatoire de
l'U.S  Naval.  Dimension  4  en  est  un  exemple  pour  le  système  Windows  (voir
http://www.thinkman.com/dimension4/). La période de mise à jour devrait être d'au moins toute
les 2 heures.

7.  Système  temporelle: Comme  il  existe  plusieurs  systèmes  temporelles,  l'observateur
d'exoplanète devrait porter attention à celui utilisé pour les prédictions de transits, qui sera inscrit
dans l'en-tête de l'image FITS et utilisé pour la modélisation de la courbe de lumière, etc. Les
plus communément utilisés sont les suivants:

a. Julian Date/Universal Coordinated Time (JD_UTC),

b. Heliocentric Julian Date/Universal Coordinated Time (HJD_UTC),

c. Barycentric Julian Date/Barycentric Dynamical Time (BJD_TDB).

En cas de collaboration amateur/professionnels, le système BJD_TBD devra être utilisé.

Ce guide est  organisé selon les étapes chronologiques qu'un observateur d'exoplanètes  devra
suivre:

1. Phase de préparation

2. Phase de Capture d'Image 

3. Calibration, Photométrie, phase de traçage et de modélisation.

V. Phase de  Préparation
A. Collecte des informations

L'appendice  A décrits  une  feuille  Excel  destinée  à  l'enregistrement  de  certaines  informations
critiques durant chaque phase et fournir une source d'information pour AIJ. Si aucun changement
n'est  fait  concernant  les  instruments  d'observations  ou  la  localisation,  les  points  12-23  de
l'appendice A peuvent servir pour plusieurs sessions d'observation. La dernière version de la feuille
Excel peut être chargé depuis http://www.astrodennis.com.  Les données décrites dans l'appendice A
sont  utilisées  comme exemple  dans  ce  guide,  à  savoir  la  modélisation  d'un  transit  complet  de
l'exoplanète WASP-12b

B. Considérations sur la sélection d'une exoplanète cible

Les sources de prédictions d'exoplanètes pour une période donnée en un lieu d'observation donné
sont les suivantes:

• NASA Exoplanet Archive: http://exoplanetarchive.ipac.caltech.edu/cgi-in/TransitView/nph-
visibletbls?dataset=transits

• Exoplanet Transit Database (ETD) Website: http://var2.astro.cz/ETD/predictions.php

• Extrasolar Planet Transit Finder: http://jefflcoughlin.com/transit.html.

http://jefflcoughlin.com/transit.html
http://www.thinkman.com/dimension4/


Si l'observateur sélectionne sa propre cible (par exemple, une cible non spécifiée faisant partie d'une
campagne de recherche particulière),  alors les critères de sélection ci-après devront être pris en
considération :

1. Heure de début de transit -  comme la session doit démarre 1 heure avant le début du transit,
cela peut éliminer des cibles potentielles.

2. Durée du transit – avec certains transits plus long que d'autres, l'observateur voudra choisir
une candidate  dont le  temps total  de session (qui  inclut  1 heures après la  fin du transit)  lui
conviendra.

3. Magnitude de l'étoile hôte et profondeur de transit – les étoiles hôtes peuvent être rangé en 5
magnitude de 8.0 à plus de 13.0. La profondeur de transit peut aller de centièmes à des millièmes
de magnitude. L'observateur pourrait cependant vouloir choisir une cible avec une profondeur
plus grande en pourcentage.

C. Prédictions de retournement au méridien

Avec une monture équatoriale, l'observateur devrait prédire approximativement quand se produira le
retournement  au  méridien  pendant  la  session  d'imagerie.  Cette  prédiction  est  habituellement
effectuée à l'aide du logiciel de navigation de l'observateur et est utile pour que l'observateur puisse
être disponible pendant le basculement du méridien afin d'effectuer les ajustements nécessaires pour
repositionner le champ de vision du système d'imagerie aussi rapidement que possible.

D. Choix du temps d'exposition

De nos jours, les capteurs CCD typiquement ont une capacité d'accumulation de photons, au-delà de
laquelle il sature et les photons ne seront plus enregistrés. Aussi, il est critique que la cible et les
comps ne saturent jamais. Il est important que le temps d'exposition soit choisi de manière qu'on
atteigne un bon SNR (rapport signal/bruit), sans atteindre la saturation. De plus si la cible est prévu
de monter vers le méridien local et que donc sa lumière aura moins en moins de masse d'air à
traverser, on pourra alors atteindra le seuil de saturation. Il faudra en tenir compte pour le choix du
temps d'exposition. Noter que la défocalisation pourrait apporter une solution dans cette situation.

Afin de choisir un temps d'exposition adequat, une série d'images tests devront être prises avec des
temps d'exposition croissants. Le SNR pour l'étoile cible, ainsi que son ADU, pourront être mesurés
pour chaque image. La section VII.C décrit comment AIJ peut être utilisé pour déterminer le SNR
d'une  étoile.  Un  temps  d'exposition  qui  maximise  le  SNR et  évite  d'atteindre  la  saturation  est
l'objectif à viser.

E. Répertoires fichiers

Sur l'ordinateur qui héberge le logiciel de capture, on devra initialiser les répertoires suivants:

 AIJ Analysis, Bias, Darks, Flats, Test Images, and Science Images.

Note: Le terme Science Images fait référence aux images brutes du champ contenant l'étoile hôte.
Dans d'autres logiciels elles sont nommées Lights. Le sous-répertoire AIJ Analysis contiendra les
mesures et les modèles ajustés d'AIJ. Si l'utilisateur désire utiliser d'autres noms de sous-répertoires,
veillez à en tenir compte  dans les exemples qui vont suivre.

F. Stabilisation du système d'imagerie à la bonne température



Le  système  d'imagerie  devrait  être  mis  en  place  suffisamment  à  l'avance  pour  atteindre  la
température désirée, notamment s'il est refroidi.

G. Génération de Flat

Quelque soit la méthode utilisée, les flats devront être fait avant ou après chaque session en utilisant
la même chaîne d'imagerie employée pour la session de Science Images, sans avoir été déplacée ou
bougée.

H. Autoguidage

L'autoguidage devrait être employé pendant la phase de capture d'images, sauf si la monture est
d'une  telle  précision  qu'elle  peut  maintenir  le  guidage  à  quelques  pixels  près  pendant  toute  la
session. La valeur réelle de "quelques" dépend du FWHM de l'étoile hôte.

Voir le paragraphe 4 dans la section IV Les bonnes pratiques ci-dessus, pourquoi l'autoguidage est
important. Le mécanisme d'autoguidage devra être calibré, si ce n'est pas déjà fait ou si le logiciel
d'autoguidage ne corrige pas automatiquement les variations en déclinaison. Si besoin, la calibration
devra aussi être effectuée pour le système d'optique adaptative.

VI. Phase de capture des images
L'observateur utilisera son logiciel préféré de capture pour les images de Science Images dans le
sous-répertoire  idoine.  Un  retournement  au  méridien  interviendra  peut-être  durant  cette  phase.
L'observateur devra:

• Suspendre la capture d'image

• Arrêter l'autoguidage

• Effectuer le retournement au méridien

• Repositionner l'étoile cible dans le champ de la camera

• Reprendre l'autoguidage

• Reprendre la capture d'images

Avant ou après la capture des images brutes, l'utilisateur pourra aussi capturer une série de dark, de
flat et de bias pour la calibration. La règle est de capturer un nombre impair (pas moins que 17)
d'images pour chaque type. Les règles pour le temps d'exposition de ces images de calibration sont
les suivantes:

1. Dark: temps d'exposition égal à celui des images brutes et à la même température.

2. Flat : le temps d'exposition dépend de la technique utilisée, mais typiquement 2 secondes ou
moins.  Toutefois,  ce  temps  peut  être  augmenté  pour  les  caméras  avec  obturateurs
automatique afin de ne pas capturer obturateur fermé.En règle générale, on crée un flat de
façon à ce que l'histogramme remplisse la moitié de la plage dynamique du capteur CCD.

3. Bias : un bias est un dark avec un temps d'exposition de 0 secondes. 

VII. Phase de Calibration, Photométrie, Traçage, et 
Modélisation 
Le  reste  de  ce  guide  assume  l'utilisationde  AIJ  pour  le  traitement  des  images  brutes  et
l'établissement de la modélisation du transit exoplanètaire. AIJ est donc déjà installé et le manuel



utilisateur a été lu. Les données du transit de l'exoplanète seront utilisées dans les exemples dans le
reste de ce guide

A. Calibration des images brutes (Science Images)

Le traitement des données (TD) par AIJ peut d'abord être utilisé pour calibrer les images brutes
prises pendant la session de capture. Note: Avant de procéder, il est hautement recommandé de lire
la section 6 (TD interface utilisateur) du guide utilisateur d'AIJ. Un développement plus approfondi
de  ces  fonctions  est  disponible  dans  les  papiers  suivants:http://arxiv.org/abs/1601.02622.   Les
fonctions TD sont initialisées en cliquant sur l'icône de la barre de menu d'AIJ. La figure 2 ci-
dessous  est  un  exemple  de  l'un  des  deux  écrans  qui apparaissent.

Figure 2. Ecran de conversion des coordonnées

La  situation  géographique  du  lieu  d'observation  (Lon,  Lat,  Alt),  ainsi  que  les  coordonnées
équatoriales J2000 de l'étoile hôte seront renseignées dans cet  écran.  Ainsi,  l'exemple ci-dessus
montre les coordonnées RA et DEC de WASP-12.

La figure 3 est un exemple du second écran.

http://arxiv.org/abs/1601.02622


Figure 3. Ecran données CCD 

Le but de l'écran des données CCD est de calibrer les images brutes avec le bias, la dark et le flat
préalablement capturés. Il existe plusieurs façons cependant de créer un bias maître, un dark maître
et un flat maître. Par exemple, les fichiers maîtres peuvent être créés de façon séparée dans cet
écran  et  ensuite  être  utilisés  pour  le  calibrage.  De  plus,  l'utilisateur  peut  employer  d'autres
programmes pour réaliser la calibration et simplement utiliser AIJ pour mettre à jour les en-têtes
FITS des fichiers calibrés. Ce processus est décrit ci-après. Dans l'exemple décrit dans la figure 3,
AIJ  utilise une seule passe pour tout accomplir: les fichiers maîtres sont créés à partir des fichiers
bias, dark et flat puis utilisés pour calibrer les 336 images brutes. Finalement les en-têtes FITS des
fichiers calibrés résultants sont mis à jour. Les fichiers dark originaux ont un temps d'exposition de
45 secondes, les fichiers flat de 3 secondes.

Note:  Il  est  primordial  que l'option "Remove Outliers"  (section Image Correction)  ne soit  PAS
sélectionnée lorsque une photométrie différentielle est mis en œuvre  et que le Polling Interval dans
le  Panel  Control  (bas  de  l'écran)  soit  à  0. De  même,  à  moins  que  l'option  "Enable  Linearity
Correction" ne soit mise en œuvre (voir Section 6.3.2.5 du guide d'AIJ), elle devrait être inactive.

AIJ est aussi capable d'opérer en "temps réel" si l'option "Polling Interval" est différent de 0. Dans
ce  cas,  au  taux  spécifié,  AIJ  contrôlera  automatiquement  le  répertoire  des  images  brutes  pour
détecter les nouvelles images dont le nom de fichier correspond au nom générique et aux numéros
spécifiés sur l'écran  CCD Data Processor.  AIJ les calibrera alors,  procédera à une photométrie
différentielle et éventuellement mettra à jour la courbe de lumière (voir les cases à cocher sous Post
Processing sur l'écran Data Processor  pour sélectionner les options nécessaires).

AIJ possède deux méthodes pour obtenir des informations essentielles tel que AIRMASS, temps
BJD_TDB, etc, qui seront utiles pendant la phase de photométrie, de traçage et de modélisation. La
première méthode est de mettre à jour le fichier des mesures qui est créé après qu'une photométrie
différentielle ait été appliquée aux images calibrées. Cette méthode est décrite dans la section D ci-
après. Cette méthode toutefois, ne met pas à jour les en-tête FITS des images calibrées, aussi à
chaque nouvelle photométrie différentielle, la misa à jour des en-têtes devra être appliquée. Vous
noterez que certains soft de capture inclut AIRMASS dans l'en-tête fichier et très probablement pas
BJD_TDB.

La  seconde  méthode,  qui  prend  place  pendant  la  phase  de  calibration,  est  d'inclure  cette
informations directement dans l'en-tête FITS des images calibrées. Ainsi , au moment où les images
calibrées sont corrigées avec le bias, dark et flat, leur en-tête FITS sont aussi mis à jour. C'est la
meilleur  des  deux  méthodes,  car  plusieurs  modélisations  peuvent  être  faites  avec  différents



paramètres de photométrie, sans avoir à mettre à jour le fichier de mesures à chaque fois avec les
informations AIRMASS et BJD_TDB.

Pour appliquer la seconde méthode, l'option General dans la section FITS header Updates doit être
coché. L'écran DP Coordinate Converter ensuite apparaît, comme dans la figure 2.

Les champs suivants seront remplis, s'ils ne le sont pas déjà, où s'ils ne sont pas inclus dans l'en-tête
FITS des images brutes:

1. Lon, Lat, Alt dans la section Geographic Location of Observation;

2. Les valeurs en RA et DEC de la cible dans la section J2000 Equatorial.

Ensuite, il est important que les images brutes aient l'information de date/heure de début de session
et le temps d'exposition. Les sections 6.3.2.6.1 et 6.3.2.6.2 du guide utilisateru d'AIJ décrivent les
mots clés reconnus qu'AIJ peut utiliser pour recueillir ces informations.

Une fois  que les  informations concernant  l'observatoire  et  la  cible  sont  renseignées et  qu'il  est
confirmé  que  les  en-têtes  FITS  contiennent  bien  les  informations  de  date/heure  et  de  temps
d'exposition, on peut alors cliquer sur l'icône dans  l'écran  Data  Processor.   L'écran  General
FITS Header Settings apparaît (figure 4)..

Figure 4. Ecran General FITS Header Settings



La portion FITS Header Output Settings de l'écran, indique quelles infos seront ajoutées aux images
calibrées (celle qui sont cochées Enable). Note: Il est suggéré que tous les mots clés soient Enable.

Finalement, bien que non fait dans cet exemple, les coordonnées WCS pour chaque étoile dans
chaque  image  peuvent  être  obtenues  en  sélectionnant  l'option  Plate  Solve dans  l'écran  Data
Processor.

En utilisant  l'exemple  ci-dessus,  lorsqu'on clique  sur  le  bouton  START,  la  routine  DP réalisera
automatiquement les étapes suivantes:

1. Créer un Bias Maître (mbias.fits) à partir des 16 images bias.

2. Créer un Dark Maître (mdark.fits) à partir des 16 images dark. Corrigez ce Dark Maître avec
la Bias Maître. 

3. Créer le Flat Maître (mflat.fits) à partir des 16 images flat de la manière suivante:

1. Calcule d'abord un facteur d'échelle qui représente le rapport des temps d'exposition des
flat et des dark. Dans notre exemple 3/45=0,00667;

2. Effectue la correction bias à l'aide du Bias maître;

3. Effectue  la  correction  dark  à  l'aide  du  Dark  maître,  en  tenant  compte  du  facteur
d'échelle;

4. retire les gradiants;

5. Normalise les flat calibrés.

4. Les en-têtes FITS des images calibrées sont mis à jour.

5. Calibrez chaque image brute à l'aide du Bias Maître, du Dark Maître, du Flat Maître. Un
Image Display est visible pour chaque image lors de sa calibration.

6. Les images brutes calibrées sont stockées dans le sous-répertoire nommé "pipelineout" et
auront comme suffix "_out".

La Section 6 du guide utilisateur d'AIJ fournit les autres options de cet écran.

B. Construire la pile d'images

L'étape suivante consiste à réaliser une photométrie différentielle sur les images calibrées. Ceci est
accompli en chargeant d'abord celles-ci dans la pile (stack) d'AIJ. Chaque image de la pile s'appelle
un "slice" (une tranche). La pile est un ensemble d'images sur lesquelles on peut appliquer diverses
fonctionnalités  d'AIJ.  La  séquence  suivante  montre  comment  effectuer  une  photométrie
différentielle.

Chargez les images brutes calibrées dans la pile: Depuis la barre d'outils d'AIJ sélectionnez File →
Import→ Image Sequence. Sélectionnez UN fichier dans le sous-répertoire contenant les images
brutes calibrées. Un écran similaire à celui de la figure 5 apparaît.

 



Figure 5. Sequence Options Screen

Si le PC sur lequel on exécute AIJ a suffisamment de mémoire pour contenir toutes les images dans
la  pile,  on  peut  décocher  "Use virtual  stack"  sur  l'écran  Sequence  Options.  AIJ  y  gagnera  en
rapidité. Avec les options cochées comme dans la figure 5, à l'exception possible de Use virtual
stack, cliquez sur OK. 

Ceci crée la pile AIJ des images brutes calibrées.  Le  Image Display (figure 6) montre alors la
première image de la pile.



Figure 6. Image Display Screen

Afin d'être sur que les indicateurs FOV sont corrects pour les axes horizontaux et verticaux sur
l'écran  Image Display,  les  bonnes échelles en pixel  en X et  Y devraient être renseignées.  Ceci
devrait être fait si aucune coordonnées WCS n'a été trouvée en utilisant soit l'option Plate Solve ou
l'une des options WCS→ Palte Solve sur l'écran Image Display. Les bonnes valeurs en pixels sont
renseignées en sélectionnant en haut de l'écran Image Display, "WCS→Set pixel scale for images
without WCS….".

Le curseur en dessous l'image permet de se déplacer à travers toutes les images en vue d'en trouver
à éliminer à cause de défaut patent, comme un passage de nuages, un guidage insuffisant ou autre.
Si les images montrent un degré de mauvais alignement croissant, voir le paragraphe 3 ci-dessous. 

Les images à rejeter peuvent être effacées à l'aide l'icône .  Ou  par  le  menu  Edit→Stack→
Delete.



C. Réaliser une photométrie différentielle

1. Sélectionnez les paramètres d'ouvertures et d'anneaux adéquats.

La première étape est de définir le rayon d'ouverture et les rayons internes et externes de
l'anneau. Ceci se fait comme suit:

L'icône  sur  l'écran  Image  Display est  sélectionnée  causant  l'ouverture  de  l'écran  de
paramétrage de la photométrie.

Figure 7. Ecran Aperture Photometry Settings

Le rayon  initial d'ouverture et de ceux de l'anneau peuvent être paramétrés en utilisant l'une des
trois méthodes suivantes:

Méthode 1.  Les  rayons peuvent  être  déterminés  en utilisant  l'écran Seeing Profile  associé  avec
l'étoile cible. Cet écran apparaît lorsque l'étoile cible est ALT-cliquée. Le rayon de la source et les
valeurs de début/fin du fond du ciel peuvent être utilisées pour déterminer le rayon d'ouverture
initial et les rayons interne et externe de l'anneau.

Méthode 2. Le rayon initial peut aussi être déterminé selon le process suivant:

1. Le rayon initial  de la  source (r1)  devrait  être  d'au moins  2 fois  le  nombre de  pixel  du
FWHM.

2. Le rayon interne de l'anneau (r2) devrait être choisi de façon à ce que celui-ci et le rayon
externe crée un anneau qui exclut toutes étoiles . Notez que AIJ tentera de toute les façons
automatiquement d'ignorer les pixels des étoiles dans la région annulaire.

3. Le rayon externe de l'anneau devrait être égal à (4*r12+r22)2. Ceci devrait conduire à avoir
un anneau comprenant 4 fois le nombre de pixels de la source.

Méthode  3.  Finalement,  les  paramètres  des  rayons  source/anneau  peuvent  être  déterminés  en
utilisant ceux qui maximise le SNR de l'étoile cible. AIJ peut être utilisé pour déterminer le SNR de
l'étoile cible comme suit:

1. Cliquez sur l'icône de paramétrage de la photométrie dans l'écran Image Display. Réglez
les rayons d'ouverture et de l'anneau et cliquez sur OK.



2. Cliquez sur l'icône de Photométrie simple (Single Photometry) dans  le  menu  AIJ.
Placez les cercles concentriques résultants sur l'étoile cible dans l'écran  Image Display et
cliquez gauche.

3. Ceci produira une nouvelle table de mesure qui devrait inclure la mesure du SNR dans la
colonne Source_SNR.  Chaque modification  ultérieure  des  paramètres  d'ouverture  et  des
sélections de photométrie à ouverture unique ajoutera une nouvelle ligne à cette table.

Note:  Chaque  ligne  nouvellement  créée  dans  la  table  Mesures  devrait  alors  être
supprimée avant que la table des Mesures ne soit utilisé pour la modélisation du transit. Cela se fait
en mettant en surbrillance la (les) ligne(s) à supprimer dans la table Mesures, puis en sélectionnant
Edit -> Cut dans la barre de menus de la table Mesures.

Les réglages finaux des rayons d'ouverture et d'annulaire devraient être ceux qui minimisent le carré
de la racine (RMS) des résidus de la courbe de lumière créée lors de l'ajustement du modèle.  Le
RMS  est  une  mesure  de  la  façon  dont  le  modèle  «correspond»  aux  données  observées.  Cela
implique que plusieurs exécutions de l'ajustement du modèle, comme décrit dans la section E ci-
dessous, doivent être réalisés avec des valeurs différentes pour les réglages de l'ouverture et des
rayons annulaires.

2. Préparez vous et commencez la photométrie différentielle  

En parcourant les images dans la pile, il se peut qu'elles soient progressivement décalées
l'une de l'autre et ne soient donc pas toutes alignées. Le paragraphe 3 ci-dessous montre
comment traiter différents degrés de désalignement, ainsi qu'un retournement au méridien. 

Sur l'écran de paramétrage de la photométrie (figure 7), l'utilisateur devrait saisir une liste de
mots-clés séparés par une virgule pour toutes les valeurs des en-têtes FITS qu'il voudrait
extraire et ajoutez à la table des mesures. Plus, les valeurs appropriés de gain de la caméra
CCD, du bruit de lecture et du courant de dark. Finalement, les paramètres adéquats d'alerte
de  saturation et de linéarité devraient aussi être renseignés. Toutes les autres cases à cocher
peuvent être conservées comme sur la figure 7.  Cliquez sur OK.

Ensuite  sélectionnez  l'icône dans la barre de menu de l'écran  Image Display pour faire
apparaître  l'écran  de Mesures  multi-photométrie  (figure  8).  Les  valeurs  pour
l'intervalle d' images, rayon d'ouverture, rayon anneau interne, rayon anneau externe sont
automatiquement remplies.Si les images ont été résolues astrométriquement, alors "Use RA/
DEC to locate aperture positions" devrait être coché (voir l'alternative 2 au paragraphe 3 ci-
dessous). Toutes les autres cases à cocher peuvent être conservées comme sur la figure 8.



Figure 8. Multi-Aperture Measurements

L'utilisateur devrait aussi avoir les icônes suivantes disponibles dans la barre de menu de l'écran
Image Display:

Ces sélections permettent d'afficher les anneaux d'ouverture / anneau avec les noms de cible et
des  comps  et  les  comptages  d'intensité  associés,  et  aide  à  positionner  automatiquement  les
anneaux d'ouverture / annulaire sur le centre de l'étoile.

L'utilisateur sélectionne ensuite  Place Apertures,  positionne et clique les cercles concentriques
flottants sur l'étoile cible et les comps. L'écran  Image Display devrait apparaître similaire à la
figure 9



Figure 9. Sample Image with Aperture/Annulus Applied to Target and Comp Stars

Ensuite  par Enter sur le clavier, le processus de photométrie différentielle va commencer. Une table
de mesures sera construite, chaque ligne représentant les mesures d'une image de la pile. Les labels
dans  la  table  de  mesures  identifient  le  type  de  données  de  la  colonne.  Certains  de  ces  labels
correspondent aux identifiants communs des en-têtes FITS et d'autres sont les mots-clés spécifiés
dans l'écran de paramétrage de la photométrie (figure 7).

A ce  stade,  la  table  de  mesures  devrait  être  sauvegardée  dans  le  répertoire  AIJ  Analysis  par
File→Save As dans le menu de la table de mesures.

3. Traiter des images mal alignées ou un retournement au méridien

Un décalage dans l'orientation d'une image et donc un mauvais alignement peut être causé par un
guidage insuffisant. Si le décalage n'est pas trop important, la fonction d'AIJ,  Align Stack pourra
être utilisée pour aligner les images dans la pile active. Sélectionnez l'icône Align  stack  using
apertures, sur l'écran Image Display et saisissez un réglage d'ouverture assez grand  et  les
réglages correspondants pour l'anneau. Les images de la pile sont alors alignées à l'aide de cette
fonction et stockées dans un nouveau répertoire "aligned".  Ces images seront celles utilisées pour
la photométrie différentielle.

1. Si  le  retournement  au méridien survient  pendant  la  session d'imagerie,  alors  les  images
devront être pivotées de 180° par rapport à l'orientation affichée dans la figure 9. ainsi, pour



les images prises après le retournement, les anneaux d'ouverture/annulaire ne devraient pas
tomber sur la bonne position pour l'étoile cible et les comps. Note: Même si la caméra CCD
elle-même  était  pivotées  immédiatement  après  le  retournement  et  avant  de  reprendre
l'imagerie, il est improbable que l'étoile cible et les comps se retrouvent au bon endroit sur le
capteur.
Aussi, dans le cas d'une rotation d'image due à un retournement au méridien ou en cas de
décalage sévère, les cercles ouverture/anneaux doivent être rpositionnés sur l'étoile cible et
les comps. AIJ offre deux façons de faire ceci.

Alternative 1.

Des passes complémentaires sur différentes zones de l'image sont effectuées pour replacer les
cercles d'ouvertures/anneaux sur ces images où un tel décalage sur la position de l'étoile cible et
des comps est constaté. Une façon de le faire est de savoir si les images étaient sur le côté Est
avant  que  le  retournement  ne  se  produise,  quelles  images  étaient  du  côté  ouest  après  le
basculement,  puis  d'exécuter  plusieurs  cycles  de  photométrie  différentielle  et  combiner  leurs
table de Mesures respectives. 

D'abord  effacer  les ouvertures  et  les  annotations  de  l'écran  Image  Display en
sélectionnant  l'icône dans la  barre  de menu.  A l'aide du curseur,  détermine l'intervalle
d'images  sur  lequel  la photométrie  différentielle  doit  s'appliquer.  Le numéro d'image est
visible en haut de l'écran à gauche du nom de fichier de celle-ci.

S'il en existe, les lignes correspondantes dans la table de mesures doivent être effacées. Pour le
faire, sélectionnez les lignes à effacer (clic sur la première ligne et shift-clic sur la dernière). Puis
depuis la barre de menu faire Edit→ Cut.

Ensuite, sélectionnez l'icône   pour rappeler l'écran de Multi-photométrie. (Note: Si un process de
photométrie différentielle précédent a été effectué, il peut être nécessaire de déselectionner "Use
previous  ...apertures).  L'intervalle  de nombre d'images  de la  pile  à  traiter  doit  être  saisi.  Le
bouton Place Apertures est ensuite sélectionné.

Finalement, les ouvertures/anneaux doivent être placés sur l'écran  Image Display sur la même
cible et les mêmes comps, dans le même ordre que pour la photométrie différentielle initiale.

Notez que les tables de mesures sont mises à jour avec un nouvel ensemble de lignes de cette
photométrie différentielle.

Alternative 2.

Cette seconde alternative pour traiter des décalages d'images implique les étapes suivantes:

D'abord, résolvez astrométriquement chaque image. Ceci détermine le WCS (World Coordinate
System) les coordonnées RA et DEC pour chaque étoile de chaque image de la pile.  Ceci est
réalisé  en  sélectionnant  depuis  le  menu  l'écran  Image  Display "WCS→  Plate  solve  using
Astrometry.net (with options)…". Un écran similaire à celui de la figure 10 apparaît.

 



Figure 10. Astrometry Settings 

L'utilisateur  devra  d'abord  saisir  sa  clé  d'utilisateur  Astronomy.net  (obtenu en s'enregistrant  sur
astrometry.net). Ensuite, les valeurs corrects de Pixel Scale doivent être renseignées, aussi bien que
les  coordonnées  RA  et  DEC  du  centre  de  l'image.  Sélectionnez  START,  et  la  résolution
astrométrique commence.

Après sa réalisation, l'utilisateur peut effectuer une photométrie différentielle comme auparavant,
sauf  que  dans  l'écran  Multi-Apertures  Measurements,  la  case  "Use  RA/Dec  to  locate  aperture
positions" doit être décochée. De plus, le premier et le dernier numéro image doivent englober la
totalité des images – aussi bien celles avant le retournement au méridien que les suivantes. Lorsque
le bouton Place Aperture  est sélectionné sur cet écran, l'utilisateur devrait alors placer les cercles
ouvertures/anneaux sur l'étoile cible et les comps, comme précédemment, et appuyer sur ENTER sur
le clavier. Toutes les images de la pile vont être maintenant anaysées.

Notez que la résolution astrométrique peut prendre un certain temps selon le nombre d'images de la
pile, auquel cas l'alternative 1 serait préférable.

D. Préparation de l'ajustement du modèle

L'icône Multi-Plot Main dans la barre d'outils de AIJ doit être sélectionnée. Lorsque c'est fait,
les quatre fenêtres suivantes s'affichent:

Multi-plot Main

Multi-plot Reference Star Settings

Multi-plot Y-data

Data Set 2 Fit Settings.

La première  étape  est  de mettre  à  jour  les  valeurs  dans  les  colonnes  AIRMASS,  HJD_UTC et
BJD_TDB dans la table de mesures si cela n'a pas été fait durant la phase de calibration (voir la
section A ci-dessus). Ceci est réalisé comme suit:



Depuis le menu  Multi-Plot Main, sélectionnez "Table→ Add new astronomical data columns to
table". Les deux écrans suivants apparaissent: "MP Coordinate Converter" et  "Add astronomical
data to table" (voir figure 11).

Figure 11. Screens for Correcting AIRMASS and Time Standard Values

Sur l'écran  MP Coordinate  Converter,  vérifiez que les  valeurs  sont  correctes  pour  Geographic
Location  of  Observatory et  J2000  Equatorial  Coordinate pour  l'étoile  cible.  Sur  l'écran  "Add
astronomical data to table", vérifiez que les cases sont cochées comme ci-dessus dans la partie
droite de l'écran de la figure 11 et ensuite sélectionnez Update Table. Appuyez sur OK si la boîte de
dialogue "Over-write existing data?" apparaît. Les colonnes AIRMASS, HJD_UTC, BJD_TDB de
la table de mesures seront mis à jour.

E. Confectionner le modèle

Sur  l'écran  Multi-Plot  Main,  renseignez  les  champs  Title  et  Subtitle (voir  Figure  12).  Dans  le
panneau Fit and Normalize Region Selection, les saisies sont faites pour les cases Left et Right qui
représentent  l'heure  de  début/fin  du  transit  respectivement  (en  date/heure  Julien,  la  partie
fractionnaire).  En haut à droite de l'écran Multi-Plot Main, l'icône Copy est  ensuite
sélectionnée. Ceci positionne les marqueurs prévisionnels d'entrée et de sortie  prédits  aux
endroits appropriés sur l'écran  Plot of Measurements. Ces marqueurs prédits ne doivent pas être
modifiés, pour qu'ils puissent servir de comparaisons. Cependant, les marqueurs  Fit et  Normalize
doivent être positionnés sur les points d'entrée et de sortie apparents, comme indiqué sur l'écran
Plot of Measurements (Figure 18). En outre, les champs Left Trim et Right Trim peuvent être utilisés
pour éliminer une quantité de données de pré-entrée et de sortie après la sortie du modèle. Cela
pourrait  se  faire,  par  exemple,  s'il  y  avait  une  systématique au début  ou à  la  fin  de la  séance
d'observation.

Ensuite, dans le panneau X-Axis Scaling, cochez le bouton Auto X-range et cliquez sur l'icône 

Les cases  X-min  et  X-max seront remplies automatiquement avec les valeurs minimales et
maximales  (en  temps  BJD_TDB dans  cet  exemple)  de  la  table  des  mesures.  Alternativement,
l'utilisateur peut cliquer sur la case Custom-X-range et la remplir avec des valeurs différentes pour
X-min et X-max. Le panneau Y-Axis Scaling peut être utilisé maintenant ou plus tard pour permettre
aux différents points d'être dimensionnés comme sur l'écran Plot of Measurements (voir figure 18).
Les champs Plot Size sont utilisés pour dimensionner l'écran Plot Measurements sur le moniteur de
l'utilisateur.



Figure 12. Ecran Multi-plot Main 

Si un retournement au méridien est intervenu, ou s'il y a une interruption dans l'imagerie et que les
étoiles se sont déplacées sur le capteur CCD, alors la boîte  Meridian Flip de l'écran  Multi-Plot
Main sera utilisée pour placer une ligne au milieu de l'intervalle d'interruption où la discontinuité
des données est intervenue. La case Show devra être cochée et une donnée saisie dans la case Flip
Time de  façon  à  placer  le  retournement  au  méridien  à  la  bonne  place  sur  l'écran  Plot  of
Measurements.

G. Traçage de la courbe de lumière

Avant qu'un affichage visuel des données puisse êtree obtenu via l'écran  Plot of  Measurements
(figure 18), l'écran  Multi-plot Y data (figure 13) doit être paramétré. C'est le principal écran qui
détermine où et comment les données seront tracées.



Figure 13. Multi-plot Y Screen

Ce qui suit constituent les paramètres clés et les sélections pour l'écran Multi-Plot Y:

La colonne Plot est utilisée pour sélectionner si une donnée particulière doit être tracée.

La  colonne  Y-data est  utilisé  pour  sélectionner  quel  ensemble  de  données  (à  savoir  quelles
colonnes de la table des mesures) est associé avec quel ligne.

La colonne Bin-Size indique le nombre de points dans l'ensemble de données associé qui seront
regroupés en un seul point. Typiquement, seul le flux relatif associé avec les comps (rel_flux_Ci)
est regroupé. Notez que le regroupement est dans un but d'affichage uniquement, les données ne
sont pas modifiées dans la table de mesures.

La colone  Fit  Mode est  utilisée pour sélectionner  le type d'ajustage qui doit  être appliqué à
l'ensemble de données ainsi que l'amplitutde des données (indique par la zone verte) qui sera
appliqué à l'ajustage. Ainsi, comme vu dans la figure 18, les points des lignes de données de
variation relatif du flux en  T1 sont affichés sans ajustage;  tandis que le deuxième point est un
ajustage des mêmes données utilisant un modèle de transit. Finalement, les variations relatifs de
flux de 3 comps sont ajustées avec un modèle linéaire (comme on verra plus tard, l'uns des
comps, C5 a été dé sélectionnée après que l'on ait constaté des erreurs résiduelles significatives).
Le pourquoi des 3 derniers tracés en mode linéaire est que il est assumé qu'il ne devrait pas y
avoir de variations relatives dans la brillance des comps pendant toute la session d'imagerie,
contrairement  au flux relatif  T1 où il  est  assumé qu'il  reflète  un creux du à un transit  exo-
planétaire.

La colonne Trend Select sert à deux choses. D'abord, elle reflète le Detrend paramètres qui sont
appliqués aux Fit Mode associés, lesquelles eux-même seront sélectionnés sur l'écran DataSet 2
Fit (figure 14). Les paramètres Detrend actifs sont indiqués en vert. 

Deuxièmement,  la sélection d'un paramètre de  Detrend particulier réflètera son coefficient de
tendance et le type de données de déformation associé (par exemple, AIRMASS).

La colonne  Norm/Mag Ref indique la plage de données utilisée pour normaliser l'ensemble de
données. Dans cet exemple, figure 13, le flux relatif de T1 est normalisé d'après les données hors



transit – données à gauche du début de transit (ingress point) et à droite de la fin de transit
(egress  point).  Ces  deux derniers  points  sont  positionnés  par  les  valeurs  des  champs  Fit  et
Normalized Region Selection sur l'écran Multi-Plot Main (figure 12).

Lorsque la colonne Page Rel est cochée, elle indique que les valeurs des colonnes Scale et Shift
devraient être interprétées comme le pourcentage d'amplitude de Y-range. Non coché, cela veut
dire que les valeurs des colonne Scale et Shift sont des nombres absolus appliqués à Y-range. Les
valeurs des colonnes Scale et Shift, avec celles de Y-min et Y-max dans l'écran Multi-Plot Main,
sont utilisées pour positionner proprement les différents points sur l'écran Plot of Measurements.
On doit noter que la ligne de données représente le flux relatif de T1 (la première ligne sur la
figure 13) doit  toujours avoir  une valeur  Scale=1.  Ceci parce que ces données peuvent  être
utilisées par d'autres programmes d'ajustement et ne doit donc être dimensionné.

L'écran de configuration des jeux de données 2 (Figure 14) s'ouvre automatiquement chaque fois
qu'il y a un ajustement de transit sélectionné pour un ensemble de données (dans ce cas, Ensemble
de données 2) dans la colonne Fit Mode sur l'écran Multi-Plot Y (Figure 13). Les entrées utilisateurs
suivantes sur l'écran Data Set 2 Fittings effectuées, affectent la courbe de lumière:

Period –  saisir  la  période  orbitale  depuis  http://exoplanets.org/;  dans  le  cas  de  WASP-12b
1.09142245 jours.

Paramètres étoile hôte – Saisir le type spectral (Sp.T) de l'étoile hôte; uniquement pour estimer le
rayon  R*  de  celle-ci,  dont  on  en  déduira  le  rayon  orbital  de  l'exoplanète.  Dans  l'exemple,
R*=1,630 issu de http://exoplanets.org/.

Quad LD U1 et Quad LD U2 – sont les facteurs d'assombrissement du limbe stellaire de l'étoile
hôte, associé  au filtre utilisé.  Ces valeurs peuvent être trouvées en utilisant l'outil de calcul du
coefficient  d'obscurcissement  du  limbe  à
http://astroutils.astronomy.ohio-state.edu/exofast/limbdark.shtml.  Dans  cet  exemple,  pour
WASP-12b  les  coefficients  sont  0.39056084  et  0.3026992.  Notez  qu'ils  sont  placés  dans  la
colonne Prior Center et verrouillés.

La valeur de AIRMASS Prior Center doit être initialisée à 0.0 dans la plupart des cas.

http://astroutils.astronomy.ohio-state.edu/exofast/limbdark.shtml
http://exoplanets.org/
http://exoplanets.org/


Figure 14. Ecran Data Set 2 Fit Settings 

Les  valeurs  Y-min  et  Y-max sur  l'écran  Multi-Plot  Main peuvent  être  ajustées  pour  afficher  les
portions désirées de la table des mesures sur le graphique, aussi comme mentionné précédemment,
il est préférable de sélectionner Auto-X-range sous X-Axis Scaling  sur l'écran Multi-Plot Main pour
afficher la totalité des X-values.

Il  est  possible  de  voir  comment  l'ajustement  est  amélioré  en  appliquant  différents  paramètres
Detrend. Le plus commun étant AIRMASS. D'autres paramètres Detrend peuvent aussi être choisis.
Si un retournement au méridien ou un gap dans la collection de données est intervenu, déplaçant les
étoiles sur le capteur CCD, alors le paramètre Meridian_Flip peut aussi être sélectionné (notez qui
si ceci est fait, la sélection de Flip Time et sa valeur doit se faire dans l'écran Multi-Plot Main). Une
bonne règle de base pour savoir si un paramètre  Detrend est effectif, c'est  de voir la valeur de
bayesian Information Criterion (BIC). Si elle diminue de plus de 2, alors le paramètre devrait être
sélectionné. Si elle diminue de moins de 2 ou augmente, le paramètre n'est pas pertinent.

Finalement, l'écran Multi-Plot Reference Star Setting (Figure 15) est utilisé pour désélectionner ou
sélectionner quelles étoiles comps l'utilisateur veut inclure dans le modèle ajusté. Ceci est utile s'il
est  déterminé  après  avoir  visionné  un flux  relatif  d'une  étoile  particulière  dans  l'écran  Plot  of
Measurements (Figure 18) que ses points de données ne suivent pas un ajustement linéaire, c'est une
indication qu'on est probablement en présence d'une étoile variable. Dans notre exemple, il & été
déterminé  que  l'étoile  comp  C5  a  un  grand  nombre  d'erreurs  résiduelles.  Aussi  elle  a  été
désélectionné. Lorsque celle-ci a lieu, l'identifiant de létoile C5 est changé en T5 à la fois sur l'écran
décrit en figure 16, et sur l'écran image Display (voir figure 17). Sa case de sélection dans la figure
13 a été décochée, ce faisant son tracé n'apparaît plus dans la figure 18.



Figure 15. Ecran Multi-plot Reference Star Settings 

Figure 16. Ecran Multi-plot Reference Star Settings  après que C5 ait été désélectionné.



Figure 17. Ecran Images Display mis à jour montrant C5 changé en T5

Notez que les données de C5 ne sont pas incluses dans le modèle ajusté, mais elles sont toujours
présentes dans la table des mesures.

Les paramètres dans les figures 12-14 et 16 produisent la courbe de lumière et autres tracés comme
décrit dans la figure 18

La  figure  19  est  un  exemple  d'un  modèle  d'exoplanète  basé  sur  les  données  collectées  par
l'astronome amateur Paul Benni pour Wasp-76b. Elle montre comment le paramètre Meridian_Flip
Detrend a été utilisé pour prendre soin d'un décalage dans les points de données causé par la cible et
les comps situés sur une zone différente du capteur CCD après que le retournement au méridien soit
intervenu.



Figure 18. Plot of Measurements Screen



Figure 19. Exemple d'utilisation du paramètre Meridian_Flip Detrend

H. Sauvegarde des données du modèle

Puisque tous les modèles précédents et detrending ne changent pas la table des mesures, l'utilisateur
serait  avisé  de  sauver  le  status  courant  de  celles-ci  et  des  paramètres  des  autres  modèles



d'ajustement par  File→ Save amm  ou  File → Save all (with options) depuis l'écran   Multi-plot
Main.

I. Optimisation du modèle

Avec les diverses données que l'observateur d'exoplanètes peut modifier qui peut affecter le modèle
pour un ensemble de données, plusieurs questions se posent:

1. Quelles variables doivent être modifiées ?

2. Dans quel ordre ?

3. A quel moment le modèle est-il optimal ?

Afin de répondre à ces questions, suivez les conseils suivants. Ils ont pour objet d'optimiser un
transit complet et non pas un transit partiel:

1. Etablir  un  premier  modèle  en  sélectionnant  les  étoiles  comps  et  les  tailles
d'ouvertures/anneaux  suggérées  plus  tôt  dans  ce  guide,  avec  AIRMASS comme  seul
paramètre  Detrend.  Si  un  retournement  au  méridien  a  été  fit,  alors  le  paramètre
Meridian_Flip doit  être  activé tout  au long des  étapes  ultérieures.  Notez  le  RMS de la
courbe de lumière (voir Figure 14).

2. Utilisez l'écran   Multi-Plot  Reference Star  Settings (voir  Figure 15) pour déterminer  les
effets  sur  le   RMS de  la  suppression  de  différentes  étoiles  comps.  SI  le  RMS décroit
lorsque'une étoile comps donnée est désélectionnée, alors conservez-la, comme cela a été
fait avec C5 dans l'exemple en Figure 16.

3. Avec la sélection comme ci-dessus d'étoiles comps  et  AIRMASS comme seul paramètre
Detrend (plus  Meridian_Flip  éventuellement), changez les rayons d'ouverture/anneaux en
les augmentant et ensuite et les diminuant, relancez Multiple Aperture (voir Section VII.C)
pour chaque combinaison et ensuite déterminez les effets sur le RMS pour chacune.

4. Répétez l'étape 2 sur ces nouveaux rayons pour aboutir au meilleur RMS. En plus de la
valeur RMS résultante, enregistrez la valeur BIC qui convient avec le meilleur RMS (voir
figure 14).

5. Déterminez les effets des différents paramétres  Detrend. D'abord, supprimez le paramètre
AIRMASS et regardez si la valeur BIC augmente d'au moins 2 ou plus. Dans ce cas, gardez
le paramètre  AIRMASS.  Ensuite, ajoutez les paramètres  Detrend suivants, un à la fois et
observez les changements de la valeur BIC:

a. Width_T1,

b. Sky/Pixel_T1,

c. X(FITS)_T1,

d. Y(FITS)_T1,

e. tot_C_cnts,

f. time (e.g., BJD_TDB),



g. CCD-TEMP.

Si la valeur de BIC décroit de plus de 2 pour chacun de ces paramètres, gardez le.

6. Si plus de deux paramètres Detrend sont sélectionnés selon l'étape 5, essayez d'en éliminer,
une  à  la  fois  pour  confirmer  que  la  valeur  de  BIC  augmente  de  2  ou  plus.  Sinon
désélectionnez le.

7. En utilisant les paramètres Detrend retenus, répétez l'étape 2 pour voir les effets sur le RMS
en supprimant une ou plusieurs toiles comps.

On doit noter que parachevant toutes les étapes ci-dessus est optionnel. Cependant, si les résultats
du modèle sont à fournir à une équipe scientifique, on doit transférer à celle-ci toutes les images
brutes calibrées en vue de leur analyse détaillée.

VIII. Données pour programme externe

Pour  certaine  campagne  de  recherche  d'exoplanète,  l'observateur  doit  pouvoir  fournir  certaines
données pour utilisation dans des programmes externes. L'exemple ci-dessous montre comment un
fichier peut être créé pour un programme global d'ajustement qui requière pour chaque point de
données: son heure BJD_TDB, le flux normalisé de l'étoile cible, l'erreur sur flux relatif normalisé
de l'étoile cible et les valeurs de chaque paramètre Detrend utilisé dans le modèle AIJ.

Voilà comment un tel fichier:

Cliquez sur la flèche bas dans la colonne New Col  pour le groupe de données représentants le
flux relatif normalisé de l'étoile cible (dans l'exemple utilisé, ce devrait être la première ligne
dans la Figure 13). Une fenêtre pop-up s'ouvre.Faites les saisies comme sur la figure 20.

Figure 20. Ecran d'ajout de nouvelles colonnes à la table de mesures.

Lorsque OK est pressé, deux nouvelles colonnes sont ajoutées à la table des mesures. Ces nouvelles
colonnes ajoute pour chaque image le flux relatif normalisé de l'étoile cible et l'erreur de flux relatif
normalisé de l'étoile cible.

Finalement, pour générer le fichier contenant ces informations faites  File→ Save data subset to
file ...depuis l'écran Multi-Plot Main.



L'écran Save Data Subset apparaît (figure 21) et les saisies sont faites comme suit. Dans ce cas, la
valeur BJD_TDB, le flux relatif  normalisé de l'étoile cible,  l'erreur de flux relatif  normalisé de
l'étoile cible, les valeurs de  AIRMASS sont sélectionnées.  AIRMASS est inclus parce que c'est le
paramètre Detrend utilisé dans le modèle AIJ.

Figure 21. Ecran Save Data Subset 

Lorsque OK est pressé, un fichier séparé est créé qui contient ces valeurs. Note: les valeurs pour
Bin Size, Scale, Shift de l'écran Multi-Plot Y (voir figure 13) affecte les calculs du flux relatif de T1
dans cet exemple. Si aucune valeur n'a été changée, ré initialisez les à Bin Size=1, Scale=1, Shift=O
avant de cliquer sur la flèche de New Col dans l'exemple ci-dessus, sauf si de tels modifications sont
intentionnelles (par exemple, si on veut regrouper des points de données).

IX. Résumé

Comme il a été dit dans l'introduction, ce guide avait pour but d'être une pratique, pas à pas de la
calibration d'images, de photométrie différentielle, de tracé de courbe de lumière et de modélisation
de transit exoplanétaire avec AIJ. Les utilisateurs sont encouragés à contacter l'auteur à l'adresse
Email suivante pour tout suggestion de modifications sur les parties obscures et demanderaient plus
d'explication.

dennis@astrodennis.com.

Remerciements
L'auteur voudrait remercier spécialement l'auteur de AIJ, Dr. Karen A. Collins, pour ses suggestions
et commentaires à propos de ce guide.



Appendix A:
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